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Notities over handelsmerken 
Lukas is een gedeponeerd handelsmerk van Streamit. 
Streamit is een handelsnaam van ir.S.J. van der Stoel Holding BV. 
Alle andere handelsmerken en gedeponeerde handelsmerken die in deze gebruiksaanwijzing zijn vermeld, zijn 
eigendom van hun respectieve eigenaren. 
 

Copyright ©2004-2005 Streamit 
Alle rechten voorbehouden. Geen enkel gedeelte van deze publicatie mag worden overgedragen of gekopieerd, in 
welke vorm dan ook, zonder uitdrukkelijke schriftelijke toestemming. 
 

Afwijzen van aansprakelijkheid 
Deze handleiding is zorgvuldig gevalideerd en nagekeken. De aanwijzingen en beschrijvingen waren correct voor 
Lukas Terminal en de Lukas Service Kabel op het tijdstip waarop deze handleiding ter perse ging. Software 
versies, kabels en handleidingen kunnen echter zonder kennisgeving worden gewijzigd. Streamit aanvaardt 
dientengevolge geen aansprakelijkheid voor schade die direct of indirect voortvloeit uit fouten of omissies in de 
handleiding, of uit discrepanties tussen Lukas Terminal, de Lukas Service Kabel en de handleiding. 
 

Aansluiten van de Lukas Service Kabel 
 

De Lukas Service Kabel wordt aangesloten tussen de seriële of USB poort van een PC en de Service connector 
van de Lukas. In de bovenstaande tekening is aangegeven waar de Service connector zich bevindt. 
 

Als de Lukas Service Kabel aangesloten is op de Lukas blijft de LED branden, ook als de Lukas 

met de uitgezet is. 
Opmerking
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Het installeren van de USB kabel 
Als u een USB kabel hebt gekregen, moet u deze op de volgende manier installeren: 
 
Stop de bijgeleverde CD in de CD speler van de PC. 
 
Als het goed is, start nu automatisch uw webbrowser op. Als dit niet het geval is, opent u de CD met behulp van  
Windows Verkenner. Vervolgens klikt u op index.htm waarna uw webbrowser alsnog opstart. 
 
Ga naar de Downloadpagina (zie linksonder in het scherm). 
Ga op de Downloadpagina naar het onderdeel software. 
 
Klik op de link Lukas Terminal USB driver en volg de installatie instructies. 
 
Nadat de USB kabel in de PC gestopt is, wordt automatisch start de ‘nieuwe hardware gevonden’ wizard opgestart 
(Windows XP). 
Installeer vervolgens de USB drivers vanaf de directory (meestal) c:\SiLabs\MCU\CP210x\WIN. De USB drivers 
mogen ook vanaf Windows Update geïnstalleerd worden. 
 
Als het goed is verschijnt er in de hardwareconfiguratie van uw PC nu een extra COM poort met omschrijving: 
CP210x USB to UART Bridge Controller (xxx) waarin xxx het nieuwe COM poort nummer is. 
 
Ga vervolgens verder met het installeren van Lukas Terminal. 

Het installeren van Lukas Terminal 
 
Met Lukas Terminal kunt u met behulp van de PC instellen waar de Lukas z’n kanaalinformatie vandaan haalt. 
Tevens kunt u hiermee ook zelf kanalen in de Lukas of voor een internetbestand programmeren. Daarnaast kunt u 
met dit programma de firmware van de Lukas updaten. Tenslotte kan dit programma gebruikt worden om te ‘zien’ 
wat de Lukas aan het doen is. 
 
Het Lukas Terminal programma kunt u direct vanaf de PC installeren. U gaat hierbij als volgt te werk: 
 
Stop de bijgeleverde CD in de CD speler van de PC. 
 
Als het goed is, start nu automatisch uw webbrowser op. Als dit niet het geval is, opent u de CD met behulp van  
Windows Verkenner. Vervolgens klikt u op index.htm waarna uw webbrowser alsnog opstart. 
 
Ga naar de Downloadpagina (zie linksonder in het scherm). 
Ga op de Downloadpagina naar het onderdeel software. 
 
Klik op de link Lukas Terminal Vxx (xx is het versienummer) en volg de installatie instructies. 
 
Start Lukas Terminal op. U krijgt dan het volgende scherm te zien: 
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Stel Comport in op de Compoort waarop de Lukas Service Kabel is aangesloten. 
 
In de meeste situaties zal een USB service kabel automatisch gedetecteerd worden en verschijnt 
er geen Compoort keuze menu. Als de USB service kabel niet automatisch gedetecteerd wordt, 
verschijnt het COM poort nummer van de USB kabel in het compoort menu. 

 
Lukas Terminal is nu goed geinstalleerd. 

Opmerking
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Basiskennis 
 
Inleiding 
 
Voordat u aan de gang gaat met dit programma, is het belangrijk om kennis te nemen van de werking van de 
Lukas en Lukas Terminal. 
 
Voordat u aan de slag gaat met dit programma raden wij u aan om: 
 

� De handleiding van de Lukas ontvanger te lezen, zodat u weet hoe dit apparaat werkt. 
� Ervoor te zorgen dat de audiokanalen waar u naar wilt luisteren, eerst hoorbaar hebt gemaakt op een PC met 

(bijvoorbeeld) het programma Winamp. Dit programma staat op de CD waarop ook Lukas Terminal staat, 
maar kunt u ook downloaden vanaf http://www.winamp.com 

� Dit hoofdstuk goed door te lezen. 
� Het hoofdstuk Het programmeren van internettoegang en kanalen in de Lukas goed door te lezen. 

 

Het opbouwen van een internetverbinding 
 
Voor een goed begrip van de werking van de Lukas wordt eerst uitgelegd welke gegevens er in de Lukas nodig zijn 
om een verbinding met een audiokanaal via het internet te maken. 
 
Deze gegevens zijn: 

� Gegevens met betrekking tot het opbouwen van de verbinding met het internet. De Lukas kan verbinding met 
het internet maken via een telefoonverbinding (T en TE uitvoering) of een ethernetverbinding (E uitvoering). 

� Gegevens met betrekking tot de audiokanalen. Nadat een verbinding met het internet gemaakt is, maakt de 
Lukas een verbinding met het door u ingestelde en door de gebruiker gekozen audiokanaal. 

 
De Lukas in Telefoonmode 
 
Als de Lukas in Telefoonmode gebruikt wordt, zijn hiervoor de volgende parameters nodig: 
 

� Naam van de internetprovider 
� Inbelnummer 
� Gebruikersnaam 
� Paswoord 

 
De naam van de internetprovider mag vrij gekozen worden. 
 
Het inbelnummer is het nummer van de internetprovider, eventueel voorafgegaan door een 0, (nul komma) als de 
Lukas achter een huiscentrale gebruikt wordt. Let verder bij huiscentrales op dat deze geschikt zijn om met 
analoge V.92 modems te werken. Dit kunt u eenvoudig testen door met een PC of laptop die ook een V.90 of V.92 
modem heeft te proberen een internetverbinding op te bouwen en te controleren hoe deze verbinding is. Als deze 
hiervoor niet geschikt is, raden wij aan om de Lukas voor de huiscentrale direct op de telefoonlijn aan te sluiten. 
 
De gebruikersnaam en paswoord zijn nodig om verbinding met de internetprovider te krijgen. 
 
Een goedkope internetprovider in Nederland is KPN, die het product Direkt Internet aanbiedt waarvoor geen 
aanmelding vooraf nodig is.  
 
De gegevens zijn: 
 
Inbelnummer (Number):  0676012321 
Gebruikersnaam (Username):  kpn 

 Paswoord (Password):  kpn 
 



Versie 1.3       Pagina 6
De Lukas in Ethernetmode 
 
Als de Lukas in Ethernetmode gebruikt wordt zorgt de router (vaak als onderdeel van het ADSL- of kabelmodem) 
voor de verbinding met de internetprovider. Hier zijn geen verdere instellingen in de Lukas voor nodig, aangezien 
Lukas gebruik maakt van de gegevens van de router. Het is wel van belang dat de router het DHCP protocol 
ondersteunt voor het toewijzen van een IP-adres en DNS serveradres aan de Lukas. Als dit niet het geval is, 
ondersteunt de Lukas vanaf software versie 1.14 ook vaste IP adressen die met behulp van dit programma 
ingesteld kunne nworden. 
 
Als de Lukas in deze mode gebruikt wordt, mogen de ISP velden leeg gelaten worden. 

 
Het opbouwen van een verbinding met een audiokanaal 

 
Nadat de Lukas een verbinding opgebouwd heeft met het internet, moet een verbinding met een audiokanaal 
opgezet worden.  
Voor het opbouwen van een verbinding met een audiokanaal heeft de Lukas de volgende gegevens nodig: 
 

� Naam van het audiokanaal 
� URL 
 

De naam van het audiokanaal mag vrij gekozen worden. 
De URL is het adres op het internet van het MP3 audiokanaal. Een aantal voorbeelden van URLs van dit soort 
kanalen zijn: (let op: dit zijn fantasie – URL’s, dus geen echte kanalen!) 
http://212.84.78.213:8000/live
http://64.84.55.243:80/live.mp3
http://www.streamit.nl/radio.mp3
etc. 
 
Om te testen of een audiokanaal ook werkt en/of bestaat, kan de URL ingetikt worden in een programma als 
Winamp (in File -> URL) (dit programma staat ook op de CD of kunt u gratis downloaden vanaf www.winamp.com), 
maar vaak werkt het ook door deze in de  webbrowser van de PC in te tikken (maar helaas niet altijd !!).  
De Lukas beschikt over maximaal 16 audiokanalen. Deze zijn genummerd van 1 tot en met 16. 
Een belangrijk onderdeel van Lukas Terminal is het omgaan met deze kanaalgegevens. Dit onderwerp wordt 
besproken in het hoofdstuk Het programmeren van de instellingen in de Lukas. 
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Codecs en Bitrates 

 
Er zijn veel formaten op het internet in gebruik voor het transporteren van audiosignalen. Slechts een beperkt 
aantal formaten wordt ondersteund door de Lukas. 
 
De formaten die ondersteund worden door de Lukas zijn: 
 

� MP3 streams afkomstig van Shoutcast en Icecast servers with the following samplerates / bitrates: 
 
MPEG 1.01:

Samplerate / Hz Bitrate / kbit/s 
32 40 48 56 64 80 96 112 128 

48000 + + + + + + + + + 
44100 + + + + + + + + + 
32000 + + + + + + + + + 

MPEG 2.01:
Samplerate / Hz Bitrate / kbit/s 

8 16 24 32 40 48 56 64 80 96 112 128 
24000 + + + + + + + + + + + + 
22050 + + + + + + + + + + + + 
16000 + + + + + + + + + + + + 

MPEG 2.51 2:
Samplerate / Hz Bitrate / kbit/s 

8 16 24 32 40 48 56 64 80 96 112 128 
12000 + + + + + + + + + + + + 
11025 + + + + + + + + + + + + 
8000 + + + + + + + + + + + + 

1 Zowel constant bitrate (CBR) als variabele bitrate (VBR) worden ondersteund. 
2 Incompabiliteiten kunnen optreden omdat MPEG2.5 niet een formele standaard formaat is. 
 
De volgende formaten worden niet ondersteund: 
 

� Playlists (bestanden die eindigen op .PLS en .M3U). 
 MP3PRO, Windows Media en Realaudio bestanden / streams. 
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Lukas Terminal hoofdscherm 
 

In het LTP hoofdscherm komt de gebruiker de volgende menu’s tegen: 
 

� Vanuit het File menu kan het programma verlaten worden. 
� Vanuit het Tools menu kunnen de volgende acties worden opgestart:  het configuren van de Lukas 

(Configure Lukas), het updaten van nieuwe firmware (Update Firmware) en het bekijken van de 
aangesloten Lukas instellingen (View Lukas configuration). 

� Vanuit het Window menu kan de logging in het hoofdscherm worden gewist (Clear Terminal Window) of 
opgeslagen in een tekstbestand (Save Terminal Window). Deze laatste optie is met name handig om in 
een probleemsituatie na te kunnen wat er precies mis is gegaan bij, bijvoorbeeld, het opbouwen van een 
verbinding met een kanaal. 

� De Help pagina’s kunnen worden opgestart vanuit het Help menu. 
 

De meeste acties kunnen ook opgestart worden door op een button te klikken. 

Configure Lukas. 

Update Firmware. 

Open de verbinding met de Lukas. Als deze knop ingedrukt wordt met een goed aangesloten Lukas wordt de 
softwareversie en het serienummer rechtsonder getoond. 

Verbreek de verbinding met de Lukas. Dit is alleen nodig als de gebruiker dezelfde COM poort ook voor 
andere toepassingen wil gebruiken. 

Sla de logging in het hoofdscherm in een tekstbestand op. 

Wis de inhoud van het hoofdscherm. 

Laat de configuratie van de aangesloten Lukas zien. 

Start de Help pagina’s op. 
 
Verder wordt in dit scherm de communicatie met de aangesloten Lukas weergegeven. De informatie die hier 
getoond wordt is erg handig om te volgen wat er gebeurt bij het opbouwen van een verbinding en het programmeren 
van de Lukas. 
Op de regel boven de onderste regel kan de COM poort ingesteld worden. 
Op de onderste regel is status informatie afgedrukt: linksonder de naam van de huidige configuratiefile, rechtsonder 
het serienummer van de aangesloten Lukas en helemaal rechtsonder de status van de verbinding met de Lukas. 
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Het programmeren van internettoegang en 
kanalen in de Lukas 
 
Inleiding 
 
Het Configure Lukas scherm is het belangrijkste onderdeel van dit programma. 
 

Vanuit het hoofdscherm wordt dit scherm opgeroepen door op de  button te drukken of vanuit het Tools menu 
Configure Lukas te selecteren. 
 
In dit scherm kunnen de instellingen van de Lukas aangepast, geprogrammeerd en opgeslagen worden. 
Het opslaan van de Lukas instellingen in een computerbestand gaat door middel van het Save Configuration File 
knop onderin het scherm. 
 
Het laden van de Lukas instellingen vanuit een computerbestand gaat door middel van de Load Configuration 
File knop onderin het scherm. 
 
Afhankelijk van de instellingen die gemaakt (of geladen) zijn, bevat dit scherm een aantal tabs. Het maken van 
deze instellingen wordt beschreven in het hoofdstuk Het programmeren van de instellingen in de Lukas.
Door op de OK knop te drukken, wordt dit scherm verlaten waarbij de instellingen behouden blijven. 
Door op de Cancel knop te drukken, wordt dit scherm verlaten waarbij de instellingen teniet worden gedaan. 

 

Het programmeren van de instellingen in de Lukas 

Inleiding 
De meest voor de hand liggende manier om de internetprovider en kanaalinstellingen in de Lukas te 
programmeren is door deze er ‘hard’ in te programmeren. Dit kan, en als de Lukas op deze manier gebruikt gaat 
worden dient deze in Mode 3 ingesteld te worden. 
 
Maar deze methode is niet zo handig als achteraf kanaalgegevens gewijzigd moeten worden: alle Lukassen 
moeten dan fysiek, met dit programma, van nieuwe kanaalgegevens voorzien worden. Hiervoor is de volgende 
oplossing bedacht. De kanalen worden niet in de Lukas geprogrammeerd, maar in een bestand (Web File) die 
ergens op een website in het internet geplaatst wordt. Als de Lukas zich op deze manier moet gaan gedragen, 
moet deze in Mode 2 ingesteld worden. Met LTP wordt ook het Web File bestand gemaakt. 
 
De Lukas laadt elke keer nadat deze aangezet wordt de kanalen automatisch uit het Web File bestand. 
 
De Web File kan voor elke Lukas dezelfde zijn, maar elke Lukas kan natuurlijk ook z’n eigen Web File hebben. De 
keuze is aan de gebruiker van LTP c.q. de beheerder van de Lukas(sen). Als er veel Lukassen met dit programma 
beheerd moeten worden, kan het handig zijn om alle kanalen via een database in te voeren. In dit geval moet de in 
de Lukas geen Web File, maar een Web Database Web URL geprogrammeerd worden.  
 
Voor een Web Database URL is het belangrijk dat deze eindigt op het = teken, omdat er dan bij de Web Database 
aanroep automatisch het Lukas serienummer achter geplaatst wordt. 
 
Voorbeeld:  
Als het Lukas serienummer 10000 is en de Web URL http://www.stream-it.nl/lukasdb.asp?lukasid=
dan wordt bij een kanalenupdate de volgende aanroep gedaan: http://www.stream-it.nl/lukasdb.asp?lukasid=10000

Bij een Web Database aanroep stuurt de database een bestand naar de Lukas terug waarin zich de 
kanaalgegevens bevinden. Het is belangrijk dat de nummering van de kanalen bij 1 begint en er geen ‘gaten’ in de 
nummering zitten. 
 
Het formaat van het bestand dat naar de Lukas teruggestuurd wordt is identiek aan de Web File zoals deze met 
behulp van LTP gemaakt kan worden. 
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Tot slot zijn er audioserver providers waar Streamit afspraken mee heeft gemaakt voor de koppeling van Lukas 
ontvangers. De gegevens van deze providers worden in de firmware van de Lukas geprogrammeerd en kunnen 
gebruikt worden als de Lukas in Mode 1 (= fabrieksinstelling) ingesteld is. 
In de volgende paragrafen zullen de benodigde stappen per Mode worden uitgelegd. 
 

Het programmeren van de Lukas in Mode 3 
Stel de Lukas op deze mode in als alle gegevens vast in de Lukas geprogrammeerd moeten worden. 
 
Hierbij moeten de volgende stappen worden doorlopen: 
 
Stap 1. Start het Configure Lukas scherm op. 
 
Stap 2. Selecteer in de Type tab het Lukas type dat u wilt programmeren. 
 
Stap 3. Selecteer de Mode tab. 
 
Stap 4. Selecteer Mode 3. De volgende tabs zijn nu zichtbaar: Type Mode Network Channels Program. 

Stap 5. Selecteer de Network tab. 
 
Stap 6. Lukas T/TE: Vul de gegevens van de internet provider in (ISP settings tab), bijvoorbeeld: 
 

Name   KPN 
 Number   0676012321 
 Username kpn 
 Password kpn 
 
Stap 7. Lukas E/TE: Vul de network settings gegevens in: DHCP (default) of een vast IP adres als DHCP niet 
beschikbaar is. 
 
Stap 8. Seleteer de Channels tab. 
 
Stap 9. Voeg met behulp van de Add a Channel knop de gewenste kanalen toe en/of verwijder de ongewenste 
kanalen met behulp van de Delete this Channel knop. 
 
Stap 10. Selecteer de Program tab. 
 
In het scherm staan de gemaakte instellingen. 
 
Door op de Save Configuration File knop te drukken kunnen deze instellingen in een computerbestand 
opgeslagen worden. 
 
Stap 11. Programmeer de instellingen in de aangesloten Lukas door op de Program knop te drukken.  
 

Stap 12. Controleer de gegevens in de Lukas door op de button te drukken in het hoofdscherm. 
 
Stap 13. Test de Lukas met de ingestelde gegevens. 
 
Let op: Voordat op de programmeer button gedrukt  wordt moet ervoor gezorgd worden dat de Lukas Service 
Kabel met de Lukas verbonden wordt voordat de spanning op de Lukas gezet wordt.  Als dit in omgekeerde 
volgorde gedaan wordt,  werkt de Lukas Service Kabel niet.

Het programmeren van de Lukas in Mode 2 
Stel de Lukas op deze mode in als de kanaalgegevens door de Lukas bij opstarten van het internet uit een bestand 
of database gehaald moet worden. 
 
Hierbij moeten de volgende stappen worden doorlopen: 
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Stap 1. Start het Configure Lukas scherm op. 
 
Stap 2. Selecteer in de Type tab het Lukas type dat u wilt programmeren. 
 
Stap 3. Selecteer de Mode tab. 
 
Stap 4. Selecteer Mode 2.

Stap 5. Voer de Web URL in. 
 
Stap 6. Kies de Web Method.

Stap 7. Selecteer de Network tab. 
 
Stap 8. Lukas T/TE: Vul de gegevens van de internet provider in (ISP settings tab), bijvoorbeeld: 
 

Name   KPN 
 Number   0676012321 
 Username kpn 
 Password kpn 
 
Stap 9. Lukas E/TE: Vul de network settings gegevens in: DHCP (default) of een vast IP adres als DHCP niet 
beschikbaar is. 
 
Stap 10. Als voor Use Web File gekozen is, ga verder met stap 11. 
 
Als voor Use Web Database gekozen is, ga verder met stap 20. 
 
Stap 11. Selecteer de Web File Channels tab. 
 
Stap 12. Voeg met behulp van de Add a Channel knop de gewenste kanalen toe en/of verwijder de ongewenste 
kanalen met behulp van de Delete this Channel knop. Deze kanalen wordt zometeen in het Web File bestand 
geplaatst. 
 
Stap 13. Selecteer de Program tab. 
 
In het scherm staan de gemaakte instellingen. 
 
Door op de Save Configuration File knop te drukken kunnen deze instellingen (inclusief de kanaal instellingen!) in 
een computerbestand opgeslagen worden. 
 
Stap 14. Programmeer de instellingen in de aangesloten Lukas door op de Program knop te drukken.  
 

Stap 15. Controleer de gegevens in de Lukas door op de button te drukken in het hoofdscherm. 
 
Stap 16. Selecteer de Web File Save tab. 
 
In het scherm staan de ingestelde kanaalgegevens. 
 
Stap 17. Sla de instellingen in een computerbestand op door op de Save Web File knop te drukken. 
 
Stap 18. Plaats het computerbestand met de kanaalgegevens op het internetadres dat bij Stap 5 ingesteld is. 
 
Stap 19. Test de Lukas met de ingestelde gegevens. 
 
Hieronder staan de vervolgstappen voor de Web Database configuratie: 
 
Stap 20. Selecteer de Program tab. 
 
In het scherm staan de gemaakte instellingen. 
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Door op de Save Configuration File knop te drukken kunnen deze instellingen in een computerbestand 
opgeslagen worden. 
 
Stap 21. Programmeer de instellingen in de aangesloten Lukas door op de Program knop te drukken.  
 

Stap 22. Controleer de gegevens in de Lukas door op de button te drukken in het hoofdscherm. 
 
Stap 23. Test de Lukas met de ingestelde gegevens. 
 
Let op: Voordat op de programmeer button gedrukt  wordt moet ervoor gezorgd worden dat de Lukas Service 
Kabel met de Lukas verbonden wordt voordat de spanning op de Lukas gezet wordt.  Als dit in omgekeerde 
volgorde gedaan wordt,  werkt de Lukas Service Kabel niet.

Het programmeren van de Lukas in Mode 1 
Stel de Lukas op de mode in (= fabrieksinstelling) als de internettoegang en kanaalgegevens van de in de firmware 
aanwezige providers gebruikt moet worden. 
 
Hierbij moeten de volgende stappen doorlopen worden: 
 
Stap 1. Start het Configure Lukas scherm op. 
 
Stap 2. Selecteer in de Type tab het Lukas type dat u wilt programmeren. 
 
Stap 3. Selecteer de Mode tab. 
 
Stap 4. Selecteer Mode 1.

Stap 5. Lukas E/TE: Vul de network settings gegevens in: DHCP (default) of een vast IP adres als DHCP niet 
beschikbaar is. 
 
Stap 6. Selecteer de Program tab. 
 
In het scherm staan de gemaakte instellingen. 
 
Door op de Save Configuration File knop te drukken kunnen deze instellingen in een computerbestand 
opgeslagen worden. 
 
Stap 7. Programmeer de instellingen in de aangesloten Lukas door op de Program knop te drukken.  
 

Stap 8. Controleer de gegevens in de Lukas door op de button te drukken in het hoofdscherm. 
 
Stap 9. Test de Lukas met de ingestelde gegevens. 
 
Let op: Voordat op de programmeer button gedrukt  wordt moet ervoor gezorgd worden dat de Lukas Service 
Kabel met de Lukas verbonden wordt voordat de spanning op de Lukas gezet wordt.  Als dit in omgekeerde 
volgorde gedaan wordt,  werkt de Lukas Service Kabel niet.

Lukas Terminal Logging 
 
Naast het programmeren van ISP- en kanaalgegevens kan Lukas Terminal ook gebruikt worden om te zien wat de 
Lukas aan het doen is. Het Lukas display is erg klein en om eventuele problemen te kunnen localiseren kan met 
Lukas Terminal bekeken worden wat de status van de Lukas is. 
Zodra Lukas Terminal is aangezet, begint de logging automatisch. 
 
Loggings kunnen ook opgeslagen worden met behulp van het commando Tools -> Save Response. Dit is erg 
handig om eventuele problemen of afstand te kunnen analyseren. 
Met het commando Tools -> Clear Response kan het uitvoerscherm leeg gemaakt worden. 
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Het downloaden van nieuwe firmware in de 
Lukas 

 
Het downloaden van nieuwe firmware in de Lukas gaat als volgt. 
 
Download de nieuwe firmware vanaf de Streamit website (www.stream-it.nl). 
 
Pak het gecomprimeerde bestand uit. 
 

Start vanuit het hoofdscherm het Firmware Update scherm door op de button te drukken of vanuit het Tools 
menu Firmware Update te selecteren. 
 
Let erop dat het bestand dat ingesteld bij File to Upload een bestand is dat eindigt op .HEX. De bestanden die op 
de Streamit website staan zijn gecomprimeerd, dus deze moeten eerst uitgepakt worden. Vaak zit in het 
gecomprimeerde bestand ook nog een bestand waarin de aanpassingen in de Lukas firmware beschreven staan. 
 
Start het updaten door op de Start Update knop te drukken of door de spanning van de Lukas eraf te halen en er 
weer op te zetten. 
 
In het Status scherm wordt informatie gegeven over de toestand van dit utility. 
 
In het Progress scherm wordt de voortgang van het programmeren weergegeven. Let op, het updaten van de 
firmware neemt bij 115200 bps zo’n 15-20 seconden in beslag. Bij lagere snelheden evenredig langer. 
 
Let op 1: Voordat de Upload gestart wordt moet ervoor gezorgd worden dat de Lukas Service Kabel met de Lukas 
verbonden wordt voordat de spanning op de Lukas gezet wordt.  Als dit in omgekeerde volgorde gedaan wordt,  
werkt de Lukas Service Kabel niet.

Let op 2: Wij adviseren u op de hoogst mogelijke snelheid te uploaden. Alleen als dit niet lukt, raden wij u aan 
gebruik te maken van een lagere communicatiesnelheid. 
 
Let op 3: U hoeft zich geen zorgen te maken dat u de Lukas onherstelbaar beschadigt met dit utility. De Lukas en 
LTP zijn zo ontworpen dat ze altijd blijven werken.  
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Algemene probleemoplossing 
Als u problemen ondervindt met Lukas Terminal kunt u (een van) de volgende oplossingen uitproberen of op de 
onderstaande koppelingen klikken voor meer specifieke oplossingen. 

Algemene oplossingen 
 

� Start de computer opnieuw op. 
� Controleer of het probleem optreedt in de veilige modus of Windows. 
� Treedt het probleem met LTP op terwijl u met een ander softwareprogramma werkt die gebruik maken van de 

seriële poort, zoals Faxprogramma’s, Modemprogramma’s etc. Zoja, sluit dan deze programma’s af en start 
Lukas Terminal opnieuw op. 

 
Communicatieproblemen tussen Lukas Terminal en de Lukas oplossen 
 
Als er problemen zijn met de communicatie tussen Lukas Terminal en de Lukas zijn de volgende oplossingen 
voorhanden. 

Geen communicatie met de Lukas mogelijk (1) 
Oorzaak: De Lukas Service Kabel is op de Lukas aangesloten nadat er spanning op de Lukas gezet is. 

Oplossing: Haal de spanning van de Lukas af en zet deze er weer op. Druk vervolgens op de knop waarna de 
verbinding met de Lukas geopend wordt. Als deze knop ingedrukt wordt met een goed aangesloten Lukas wordt de 
softwareversie en het serienummer zowel rechtsonder in het hoofdscherm als in het hoofdscherm zelf getoond. 
Verder ziet u rechtsonder in het scherm het bericht Connect 115k2. 

Als dit het probleem niet oplost, dan kunt u het volgende proberen: 

Geen communicatie met de Lukas mogelijk (2) 
Oorzaak: De juiste COMpoort is niet geselecteerd. 

Oplossing: Selecteer rechtsonder in het hoofdscherm de juiste COMpoort. Druk vervolgens op de knop 
waarna de verbinding met de Lukas geopend wordt. Als deze knop ingedrukt wordt met een goed aangesloten 
Lukas wordt de softwareversie en het serienummer zowel rechtsonder in het hoofdscherm als in het hoofdscherm 
zelf getoond. Verder ziet u rechtsonder in het scherm het bericht Connect 115k2. 

Geen communicatie met de Lukas mogelijk (3) 
Oorzaak: De PC ondersteunt geen 115k2 communicatiesnelheid 
Oplossing: Gebruik een PC die deze snelheid wel ondersteunt. Praktisch gezien ondersteunen alle Pentium PC’s 
deze communicatiesnelheid. 
 

Firmware update werkt niet c.q. wordt halverwege afgebroken 
Oorzaak: De communicatiesnelheid staat te hoog ingesteld 
Oplossing: Pas de Upload Speed aan in het Upload Firmware scherm en probeer het opnieuw. 
 

De PC of laptop heeft geen seriële poort 
Oplossing: Koop een verloopkabel van USB naar Seriële poort of gebruik een Lukas USB service kabel. 
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Streamit service en ondersteuning 
 
Op de volgende websites vindt u service en ondersteuning voor de producten van Streamit. Als u in het bezit bent 
van een Kerkzender Supportcontract, kunt u ook gebruik maken van onze directe telefonische- en emailsupport. 
Een supportcontract kunt u afsluiten via de webwinkel van onze website. 
 
Streamit klantenservice 
Bezoek onze website van de klantenservice op www.stream-it.nl voor meer informatie over ons 
ondersteuningsaanbod en voor algemene informatie over de Streamit producten. 
 
Streamit technische ondersteuning 
 
Bezoek onze website van de technische ondersteuning op www.stream-it.nl voor gratis toegang tot ons 
discussieforum, voor antwoorden op veelgestelde vragen en voor meer informatie over beschikbare 
ondersteuningsopties. 
 
Streamit dealernetwerk 
 
Naast directe support via onze website stellen veel van onze klanten ook persoonlijke support erg op prijs. Voor 
deze klanten hebben we een dealernetwerk opgezet. 
Verder zijn onze dealers optimaal uitgerust om met u te kijken hoe uw probleem het beste opgelost kan worden. Zo 
geldt voor een aantal van onze dealers dat zij zich gespecialiseerd hebben in het aanleggen van geluidsinstallaties 
in kerken, andere dealers zijn meer gespecialiseerd in computers en internet. 
Een overzicht van de dealers is te vinden op de Streamit website. 


